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KATA PENGANTAR

Dalam setiap penulisan karya ilmiah selalu terdapat format baku yang harus diikuti
oleh setiap peneliti. Format baku tersebut diantara adalah harus terdapat daftar isi, daftar
gambar, daftar table dan penulisan referensi dalam isi laporan tersebut.

Jika semua format baku tersebut dibuat secara manual, selain akan merepotkan tentu
akan banyak terdapat salah penulisan. Dengan menggunakan Fungsi yang terdapat dalam
Microsoft Word (semua versi), hal tersebut akan dapat dengan mudah dilakukan.

Dalam Modul ini akan dibahas tentang bagaimana cara memanfaatkan fungsi-fungsi
tersebut untuk selanjutnya dapat digunakan dalam pembuatan dokumen-dokumen ilmiah,
seperti tugas kuliah, laporan Kerja Praktek, Laporan Tugas Akhir atau Laporan Penelitian.

Tidak ada gading yang tak retak, penulis merasa panduan ini masih banyak
keurangannya. Namun dengan kekurangan yang ada semoga modul ini bermanfaat dan dapat

dipergunakan dengan sebaik- baiknya dikemudian hari.

Surabaya, Agustus 2022
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PENGANTAR PENULISAN ILMIAH

Penulisan karya ilmiah bagi siswa sekolah lanjutan, mahasiswa, dosen, guru
atau siapapun yang berkecimpung dalam bidang ilmu pengetahuan sangat penting. Hal
ini karena dengan menulis karya ilmiah, hasil pemikiran bisa disebarluaskan agar
diketahui oleh masyarakat ilmiah yang lebih luas. Selain itu, tujuan penulisan karya
ilmiah adalah membuat para peniliti untuk lebih menggali pemikiran kritis mereka
dalam bidang yang mereka geluti sehingga akan menghasilkan pengetahuan baru yang
bermanfaat bagi perkembangan ilmu pengetahuan selanjutnya (Sitoresmi, 2021).

Karya ilmiah didefinisikan sebagai Tulisan yang dibuat berdasarkan kaidah
tertentu yaitu prinsip-prinsip ilmiah yang berdasarkan data dan fakta (observasi,
eksperimen, kajianpustaka) (BadanPengembangandan PembinaanBahasa, 2016a, 2016b).
Pada kaidah tata tulis karya tulis ilmiah, yang tidak boleh dilupakan adalah sumber
refernsi yang harus dapat divalidasi kebenarannya dan validitasnya. Untuk itu perlu
tools untuk dapat mengelola semua sumber referensi tersebut. Meskipun pada
Microsoft Word sendiri sudah disediakan fungsi tersebut, tapi jika sumber yang
dibutuhkan tersimpan diberbagai tempat, fungsi yang disediakan Microsoft Word tidak
akan bisa maksimal digunakan. Aplikasi references manager banyak tersedia di internet
dan dikenal luas oleh para peneliti, diantaranya adalah EndNote, Zotero, Mendeley, dan
Citavi. Diantara beberapa aplikasi tersebut Mendeley yang paling luas digunakan (Isa,
2015).

Karya Tulis ilmiah
Tulisan yang dibuat berdasarkan kaidah tertentu
yaitu prinsip-prinsip ilmiah yang berdasarkan data
dan fakta (observasi, eksperimen, kajian pustaka)

karya ilmiah
karya tulis yang dibuat
dengan prinsip-prinsip
ilmiah, berdasarkan data dan
fakta (observasi,
eksperimen, kajian pustaka)

karya tulis
karangan atau tulisan yang
didasarkan pada fakta
maupun fiksi serta kaidah
tertentu

Gambar 1 Definisi Karya Tulis Ilmiah, Karya Ilmiah dan Karya Tulis



KARYA TULIS ILMIAH

1. Karakteristik keilmiahan sebuah karya terdapat pada isi, penyajian, dan bahasa yang
digunakan.

2. lsikarya ilmiah tentu bersifat keilmuan, yakni rasional, objektif, tidak memihak, dan
berbicara apa adanya.

3. Bahasa yang digunakan juga harus bersifat baku, disesuaikan dengan sistem ejaan

yang berlaku di Indonesia.

MENULIS KARYA ILMIAH

a. Kegiatan menulis pada dasarnya kegiatan menyampaikan atau menyajikan gagasan
atau pikiran, informasi, kehendak, kepentingan dan berbagai pesan kepada pihak lain
dalam bahasa tulis.

b. Kegiatan menulis karya ilmiah tentu dipahami sebagai kegiatan menyampaikan
pengetahuan dan temuan baru dalam suatu bidang ilmu dalam bahasa tulis.

c. Karya ilmiah biasanya menggunakan media ilmiah, seperti jurnal ilmiah atau forum
ilmiah.

BENTUK KARYA TULIS ILMIAH

Modul TUTORIAL ,
PEMBUATAN VIDEOQ PEMBELAJARAN

MENGGUNAKAN POWTOON Pembelajaran Interaktif
melalui Aplikasi Online
untuk Guru

N — ——| Modul untuk Pelatihan atau Praktikum
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POWTOON

Modul Pelatihan

THE VISUAL
COMMUNICATION
PLATFORM

Laporan Penelitian




Artikel Jurnal

Macam-macam Karya Ilmiah untuk Mahasiswa
1. Tugas Mata Kuliah
2. Proposal dan Laporan Kerja Praktik
3. Proposal dan Laporan Tugas Akhir
4. Proposal dan Laporan Skripsi
5

Proposal dan Laporan Program Kreativitas Mahasiswa (PKM)

0 B KGTS pRAST OKMI Brenrn

»PROGRAM
KREATIVITAS
MAHASISWA

2022
*

PEDOMAN UMUM

INDONESIA
2022

Gambar 2 Sampul Pedoman PKM 2022



APLIKASI PENGOLAH KATA
MICROSOFT WORD

AWAL MULA MICROSOFT WORD

untuk mengerjakan tugas sekolah sampai dengan laporan kerja. Aplikasi ini memiliki
fitur-fitur yang juga mendukung untuk melakukan desktop publishing, sehingga bisa
digunakan untuk berbagai bentuk dokumen. Aplikasi ini pertama kali muncul sekitar
tahun 1983, dimana saat itu aplikasi pengolah kata lain seperti WordStar dan
WordPerfect sedang banyak digunakan.

Fungsi-fungsi dari Microsoft terus berkembang dari mulai versi pertama sampai dengan

: o
& dj 6

.
>
- -

Gambar 3 Microsoft Office 365

Microsoft Word adalah aplikasi pengolah kata yang paling umum digunakan

versi terbaru, yaitu Offie365 (Microsoft, 2022). Fungsi-fungsi unggulan dari Microsoft
Word diantaranya adalah:

a.

C.

e.

AutoCorrect
Autopage Index
Auto Formating

Booklet layout

Mendukung format XML dan ODF
(mulai Word 2010)

J-

MailMerge

Macro

HTML editor

What You See Is What You Get
(WYSIWYG)

Mendukung untuk menghapus latar
belakang pada gambar (mulai Word
2010)



FUNGSI-FUNGSI UNTUK MENULIS KARYA ILMIAH

Penulisan proposal dan Laporan PKM harus mengikuti ketentuan yang telah
ditetapkan dalam buku panduan (pkm.dikti, 2022). Hal ini dikarenakan format penulisan
termasuk dalam poin penilaian proposal dan laporan pelaksanaan PKM. Selain dalam
PKM, format ini juga digunakan dalam penulisan laporan Kerja Praktik (KP) dan Tugas
Akhir (TA). Dari evaluasi pelaksanaan KP dan TA semester 21.1, ditemukan banyak
kesalahan format, diantaranya adalah:

1. Format Paper dan Margin

2. Format Spasi antar baris

3. Format nomor halaman

4. Format Daftar Isi, Daftar Gambar dan Daftar Tabel

5

Format caption (judul gambar/table)

Sesuai dengan evaluasi tersebut, maka fungsi-fungsi yang digunakan dalam
dokumen-dokumen tersebut yaitu:
1. Format Paper dan Margin
2. Format Page Number
3. Format Paragraph
4. Pembuatan Daftar Isi
a. Section
b. Style Heading
c. Table of Content
5. Pembuatan Daftar Gambar/Tabel
a. Caption

b. Table of Figures



FORMAT DOKUMEN ILMIAH

PEMBUATAN DAFTAR ISI

Daftar isi berisi semua judul bab dan judul sub bab yang terdapat dalam sebuah

dokumen atau laporan.

A. Section

Section digunakan untuk membarikan format yang berbeda pada setiap halaman.
Sekali Section diletakkan pada suatu halaman, maka mulai halaman pertama section itu
dimulai sampai dengan halaman terakhir section itu diletakkan maka format yang
berlaku akan sama.

Section dapat diakses melalui 7ab Page Layout > Breaks. Pada Fungsi Breaks
terdapat dua pilihan yaitu Page Breaks dan Section Breaks. Yang akan akan digunakan

selanjutnya adalah Section Breaks.

'I_-l'BreaIr.s' . ﬁ .-'}Aﬁ | -\“ Inder

Page Breaks

Page
Mark the point at which one page ends
and the next page begins.

-

i i

Column

Indicate that the text following the column
break will begin in the next column,

Text Wrapping
Separate text around objects on web
pages, such as caption text from body text,

Section Breaks

Next Page
Insert a section break and start the new
section on the next page,

-

[

Continuous
Insert a section break and start the new
section on the same page.

H

Even Page
Insert a section break and start the new
section on the next even-numbered page.

(%Y

-

llg

Odd Page
Insert a section break and start the new
section on the next odd-numbered page.

Gambar 4 Menu Breaks - Sections Breaks



Untuk memulai pembuatan section, lakukan langkah-langkah berikut:
1. Aktiflah pada halaman yang akan dikenakan section.

2. Pilih Tab Page Layout > Breaks—> Section Breaks> Next Page untuk memulai

section ke halaman berikutnya

3. Aktifkan Header/Footer dengan melakukan double click pada daerah header atau
dengan memilih Edit Header atau Edit Footer dari Tab Insert> Pilih Header atau

Footer. Karena akan membuat nomor halaman, maka pilih Footer 2 Edit Footer-

Footer -Section 1- |

Header -Section 2- Same as Previous

Gambar 5 Header dan Footer pada Section yangberbeda

4. Setelah aktif pada footer, akan tampil Toolbar khusus untuk Header & Footer.

2 . 5 " ——— e
MO e G T e Word ols.
Home Insert Page Layout References Mailings Review  View Developer Design
= = i [ = EE =7 (5, Previous [T pifferent First Page 5+ HeaderfromTop:  L27¢em 2
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Header Footer Page Date Quick Picture Clip Goto Goto i@T—; 1 = . Close Header
- -  Number+ &Time Parts~ Art ader Footer |or Link to Previous| [/] Show Document Text ﬂ Insert Alignment Tab and Footer
Header & Footer Insert Navigation Options Pasition Close

Gambar 6 Toolbar Header & Footer

5. Jika ingin membuat nomor halaman yang berbeda antara Sectionl dan Section2,
maka Tombol Link to Previous harus non aktif. Jika tidak, apapun perubahan yang

terjadi pada section sebelumnya akan terjadi juga pada section berikutnya.



Mailings Review Design

[T Different First Page
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Gambar 7 Link to Prevous off pada Header dan Footer Section 2

Untuk membuat nomor halaman pada section 1 menjadi format i, ii, iii.. dan

section 2 menjadi format 1,2, 3.. maka yang harus dilakukan adalah:

1. Aktifkan Footer Section 1dan pilih Page Number pada Group Header&Footer

e ey e

- R —

= 2 e 88

Date  Quick Picture Clip

|
L=

Goto Goto

Tieh  fiivn

& Time Fiﬂts' Art Header Footer
E@ Top of Page 3 ANavig
=
Bottom of Page v | [

Page Margins L4

Current Position 4

|
b
=
l? Format Page Mumbers...
£k

Remove Page N

Format Page Number

Change the format of page
numbering used in the header or

footer.

Gambar 9 Format Page Numbers

Page Number Format

7 )

Number format: | FPEAE A ~ |

Indude chapter number

Page numbering

@) Start at:

(@ Continue from previous section

Chapter starts with style: |Heading 1 H
UUse separator: - (hyphen) H

Examples: 1-1, 1-A

oo [ cnsl |

Gambar 8 Page Number Format
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2. Pilihlah format yang diinginkan dan mulai dari awalpenomoran.

3. Setelah memilih format penomoran, selanjutnya pilih tempat dimana nomor

halaman akan diletakkan. Ada beberapa pilihan yang terdapat pada Fungsi Page

Number, yaitu 7op of Page (pada Header) atau Bottom of Page (pada Footer).

| | Footer -Section 1-

| ﬁ

Header -Section 2-

Gambar 10 Peletakan nomor Halaman pada Header dan Footer

4. Setelah peletakan nomor halaman pertama selesai, halaman selanjutnya pada

masing-masing section akan mengikuti.

B. Heading
Untuk dapat membuatnya terlebih dahulu harus paham tentang Heading.

digunakan untuk memberikan tanda pada text yang akan ditampilkan pada D

Heading

aftar Isi.

Heading yang biasa digunakan dalam Daftar Isi adalah Heading 1, Heading 2, dan

Heading 3. Format Heading terdapat dalam Tab Home - Group Styles.

Home | Inset  Pagelayout  References  Mailings  Revie

View  Developer

Arial Body) *111 o+ A" A7 | Aa- P

T —
20 | aaBbCel| AaBbCcl AaBbi AaBbc AaBbc SRR 4a85¢ Ao
. Heading 1 Heading 2 Heading 3 Title Subtitle Subtle Em.. -

@ s
=

y - 2 . 3y 2
Frormat painter B 4 L 7 abe . X LS Thomal | THNo Spaci...

jboard ) Font Styles

A

Change
Styles =

fiis s enege X i3 3 4.0 5 i 61 7 B & | 0 | @133 B -

T

A T

VX‘LE_TI‘

Gambar 11 Styles Heading

Agar judul bab atau judul sub bab mempunyai format yang sama, maka yang

harus dilakukan adalah:

1. Arahkan Jnsertion point ke judulyang akan dikenakan format Heading

2. Pilih format heading yang diinginkan pada Group Styles.

3. Judul bab tau judul sub bab akan mempunyai format sesuai dengan Heading yang

dipilih.



dikerjakan.
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Heading

Untuk dapat membuatnya terlebih dahulu harus
Heading digunakan untuk memberikan tanda pacda 1

Gambar 12 Menggunakan format heading pada Judul

dapat dilakukan.

Yt References Mailings Fewview View
Ruler : | _t.u One Page
[ Gridiines Vo m [@d Two Pages

[ Mavigation Pane foel s Ei Page Width
Show Zoom

Gambar 13 Mengaktifkan Navigation Pane

Mavigation

Search Document

El

=

oo
oo _{4ss|

=
DAFTAR ISE
DAFTAR GAMEBAR
DAFTAR TABEL
KATA PENGANTAR
4 PEMEBUATAMN DAFTAR ISI

| Heading

Table of Content

Gambar 14 Navigation Pane Hasil Format Heading
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Tampilan format heading yang telah dikenakan pada judul bab atau sub bab
dapat dilihat dengan mengaktifkan MNavigation Pane yang berada di 7ab View - Group

Show. Navigation Pane akan tampil di sebelah kiri dokumen aktif yang sedang

Jika ingin melakukan editing pada bab yang diinginkan dapat langsung memilih
langsung dari Navigation Pane, tanpa harus melakukan scroll naik atau turun. Setelah

semua judul bab dan judul sub bab memiliki format Heading, maka pembuatan Daftar isi



C. Table of Content

Daftar isi atau 7able of Contents (TOC) yang akan dibuat dapat dipilih dari daftar

format yang telah disediakan oleh Micosoft Word atau dengan membuat format sendiri.

Daftar format yang disediakan oleh Microsoft Word terdapat pada T7ab
References -Table of Contents

References

Ep Add Text ~ [ty Insert Endnote ﬁ

— _'[‘ Update Table Ag Mext Footnaote ~ —V
Table of Insert Insert
Contents = Footnote Citation =

Built-In
Automatic Table 1

. el =Sl

Contents
1 S
Heading 2

Heading 3 2

Automatic Table 2

Table of Contents
L
Heading 3

Manual Table

Table of Contents
Type chapter title (level 1) =)
Type chapter tile (Ve 2)........uuusscesssre iass s sesms coscsssssssnsssssssssssssss s sssss seasss el
Type chapter itle (level 3)

2] Insert Table of Contents...

_:\ Remove Table of Contents

Gambar 15 Table of Contents yang dapat dipilih

a) Membuat Daftar Isi

Langkah-langkah untuk membuat daftar isi adalah sebagaiberikut:

1. Tambahkan satu halaman kosong di awal dokumen
2. Arahkan /nsertion point ke awal halaman
3. Jika akan menggunakan format daftar isi yang disediakan, pilih format yang

diinginkan. Jika ingin membuat format sendiri, ketikkan “DAFTAR ISI” di awal
halaman baru tersebut.

4. Jika memilih dari format yang telah tersedia, maka daftar isi akan langsung
tampil di halaman baru. Jika memilih untuk membuat format sendiri,
sebelum menampilkan daftarnya, letakkan terlebih dahulu /nsertion point

pada baris yang diinginkan kemudian pilih /nsert Table of Contents...

il
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Gambar 16 Daftar isi dengan format sendiri
Daftar isi telah tampil sesuai dengan format heading yang dipilih dan format TOC

yang diinginkan.

b) Update Daftar Isi
Setiap penambahan judul bab atau sub bab baru dengan format heading yang
sesuai akan ditampilkan kedalam daftar dsi tersebut. Untuk dapat menampilkan
perubahan tersebut dapat dilakukan dengan melakukan update pada daftar isi tersebut.
Terdapat 2 (dua) cara untuk melakukan update TOC, yaitu dengan memilih update
Table pada Group Table of Contents atau dengan melakukan click kanan pada daftar

isinya langsung.

= Add Text - i1 Insert |
|21 Update Table AB Next F)
Insert :
Footnote = -
of Contents Footnotes
Update Table
Update the Table of Contents so
that all the entries refer to the
correct page number,

Gambar 17 Update Table dari Group Table of Contents

Yang harus dilakukan jika melakukan update TOC dengan cara memilih update
Table pada Group Table of Contents, adalah sebagaiberikut:
1. Arahkan insertion point pada halaman Daftarisi
2. Pilih Update Table
3. Akan tampil window yang terdapat 2 (dua) pilihan update, yaitu Update Entire

Table dan Update page numbers only.
12



o Update Entire Table. menampilkan semua tambahan format heading dan

perubahan halaman yang terjadi

o Update page numbers only: hanya menampilkan perubahan yang terjadi pada

penomoran halaman

Update Table of Contents LE S
e

Word is updating the table of contents. Select one of
the following options:

(@ Update page numbers anly!
" Update entire table

0K ] [ Cancel

Gambar 18 Pilihan untuk melakukan update

4. Setelah memilih salah satu pilihan update, perubahan akan langsung terlihat pada

daftar isi.

Yang harus dilakukan jika memilih melakukan click kanan pada daftar isinya

langsung adalah:

1.
2.

3.

Lakukan click kanan pada daftar isi

Akan tampil pop-up menu dan pilih Update Field

Akan tampil kembali pilihan untuk melakukan update seperti pada
Gambar 19

Perubahan akan langsung terjadi pada daftarisi

S T T R T I TR T S e SR
[}

DAFTAR ISl

DAFTAT. = - i

arial o+ 11+ N5 47 I EE
DAFTA e r(uj=2- A- v . i
T s i
KATAI -, _ 1

PEMBL (@ Paste Options: -
Heat F A 2

Update Field

]
Tabli = 3

Edit Field...

Toggle Field Codes

Font..

Paragraph...

Bullets | »
|

Mumbering 4
b

& i TS e

Styles

Gambar 19 Update daftar isi dengan click kanan padadaftar isi
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PEMBUATAN DAFTAR GAMBAR & DAFTAR TABEL
Selain terdapat daftar isi, dalam Laporan ilmiah juga terdapat daftar gambar
atau daftar tabel. Dengan adanya daftar gambar atau daftar table, pembaca akan dapat

dengan mudah menemukan gambar atau tabel yang dicari tanpa harus membuka satu

persatu halaman dokumentersebut.

A. Menambahkan Caption

Inti dari pembuatan daftar table dan daftar gambar ini sama seperti pembuatan
daftar isi. Jika pada pembuatan daftar isi format style yang digunakan adalah Heading, di

daftar gambar dan daftar tabel ini yang digunakan adalah style Caption.

ﬂ ] Insert Table of Figures

Insert
Caption L] Cross-reference

Captions

Gambar 20 Group Captions

Sebelum membuat daftar gambar atau daftar tabel, pertama kali yang harus
dilakukan adalah menetapkan label yang akan digunakan untuk penamaan gambar atau
tabel. Dengan memilih /nsert Caption dari Group Captions akan tampil window seperti

pada Gambar 21

-y P P T s L bl

i - 'alam
Capticn v £ T
Caption:

|Figure 1 i s

i Options k

Label: Figure |Z| :
Position: | Below selected item IZ|
[7] Exclude label from caption
Mewe Label. .. slete La MNumbering. ..
| AutoCaption... ‘ | OK J [ Cancel J
1 L2 o]
New Label 2
Label:
Gambar|
[ (6]¢ ] | Cancel |
._

Gambar 21 Penulisan label caption yang akan digunakan
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Pembuatan nama label caption dapat dilakukan dengan langkah-langkah sebagai

berikut:

1. Dari window Caption, pilih tombol New Label.
2. Akan tampil window untuk mengisikan nama label baru. Isikan sesuai nama

yang diinginkan, Gambar atauTabel.

3. Tekan OK.

4. Position dapat disesuaikan. Jika Gambar, maka posisinya berada di bawah gambar.

Jika Tabel posisinya berada diatas tabel

5. Penomoran label akan otomatis dilakukan oleh Microsoft Word.

Setelah nama label dituliskan, maka gambar atau tabel yang telah ditambahkan pada

dokumen dapat diberi Caption. Cara menambahkan caption pada gambar atau tabel adalah

sebagai berikut:

1.

2
3
4.
5

Pilihlah gambar atau tabel yang akan dibericaption

. Tekan Insert Caption

Nomor gambar akan secara otomatis ditambahkan
Tuliskan judul gambar

Tekan OK

Course Caption:
|G‘ambar 1 Diagram Desain Database |

Course ng A8
Course_tifle  A30

Cptions

Label: Gambar

Position: Bélﬁ\'selectedihem = _—El
3 [7] Exclude Iabel from caption

'I Mew Label... ] I Delete Label ] [ MNumbering. .. ]
Ll

|aubac'.aption... ‘ [ oK ] [ Cancel ]

Gambar 23 Menambahkan Caption pada gambar

g R’
Caption M
‘*‘ .
Field Name Data Type | Coption:
CHEE TG Char (6) P |TabellTabelCourse |
Course Title Char(30) SR o )
Label: Tabel E
Position: | Below selected item
[ Exdude label from caption
[ Mew Label, ., ] [ Delete Label ] [ Mumbering... ]
[ Autocaption... | [ o« |[ cose |

Gambar 22 Menambahkan Caption pada Tabel
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B. Table of Figures

Setelah semua tabel dan gambar memiliki caption, maka langkah selanjutnya adalah
membuat daftar gambar atau daftar tabel. Fungsi yang dapat digunakan untuk membuat daftar
gambar atau daftar tabel adalah 7able of Figures.

Inti dari pembuatan daftar gambar atau daftar tabel sama dengan ketika membuat
daftar isi. Langkah-langkahnya adalah sebagai berikut:
1. Tambahkan satu halaman kosong setelah halaman Daftarlsi
2. Tuliskan judul bab dengan “DAFTAR GAMBAR”
3. Arahkan insertion point ke baris yang diinginkan
4

Pada 7ab References - Group Captions pilih Insert Table of Figures

Table of Figures - - G

res | | Table of Authorities

Table of Contents |

Index

Print Preview Web Preview
Gambar 1: Text ... 8 Y Gambar 1: Text A
Gambar 2: Text ... 3

Gambar 3: Text
Gambavd=Paxt:oswerye i

Clambioe 5 Mot 10
¥| Show page numbers ¥| Use hyperlinks instead of page numbers

| Right align page numbers

Tableader: |....... E|
|
General
Formats: From template |T!
Caption |abel: [ Gambar E

V] Indude label and number

|thons... H Modify... IJ

o) [

Gambar 24 Insert Table of Figures

5. Pilih Caption Label yang akan digunakan. Jika ingin membuat daftar gambar, maka pilih

“Gambar”. Jika ingin membuat daftar tabel, maka pilih “Tabel”

General

Formats: From template E|

Caption label: |Gambar -

[¥] Indude labe|Equation -
Figure 1
o —
Tabel
Table ol

Gambar 25 Memilih Caption Label yang digunakan
6. Tekan tombol OK

7. Daftar gambar atau daftar tabel akan tampil beserta nomor halaman
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Pelatihan Orientasi Kehidupan dan Kampus STMIK STIKOM Surabaya

2014

DAFTAR GAMBAR

[Gambar 1 Styles Heading
Gambar 2 Menggunakan format headingpadaJudul ..
Gambar 3 Mengaktifkan Navigation Pane

Gambar 4 Navigation Pane Hasil Format Heading..
Gambar 5 Table of Contents yang dapat dipilih
Gambar 6 Daftar isi dengan format sendiri
Gambar 7 Update Table dari Group Table of C.
Gambar 8 Pilihan untuk melakukan update
Gambar 9 Update daftar isi dengan click kanan pada daftarisi.................|
Gambar 10 Group Capti.

Gambar 11 Penulisan label caption yang akan digunakan
Gambar 12 Menambahkan Caption pada gambar ..
Gambar 13 Menambahkan Caption pada Tabel
Gambar 14 Insert Table of Figures
Gambar 15 Memilih Caption Label yang digunakan

w ko e M N e e @ o e e e e e

Gambar 26 Daftar Gambar yang berhasil ditambahkan

8. Untuk melakukan update daftar gambar atau daftar tabel, lakukan cara sama seperti

ketika melakukan update daftar isi.
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